Operating Instructions

Interface Adaptor

woe 0 KX=RC22

Please read before using.



Thank you for purchasing the Panasonic Interface Adaptor KX-RC22.

4

FOR USERS IN UNITED STATES ONLY

Naote:

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of lhe FCC Rules. These limits
are designed to provide reasonable proteclion against harmful interference
in a residential installation. This eguipment generales, uses, and can
radiale radio frequency energy and, if nol insialled and used in accordance
with the instructions, may cause harmful inlerference to radio communica-
tions. However, there is no guarantee that interference will not occur in a
parlicular inslallation. Il this equipment does cause harmful interference o
radio or television reception, which can be determined by turning the
equipment off and on, lhe user is encouraged lo Iry to correct the interfer-
ence lo radio or television reception, which can be determined by lurning
lhe equipment off and on. The user is encouraged to try 1o correct the
interference by one or more of the foliowing measures:

» Reorienl or relocate the receiving antenna.

®|ncrease the separation between |he equipmenl and receiver.

»Connect the equipmenl into an outlet on a circuit different from that ta
which the receiver is connecled.

» Consull the dealer or an experienced radio/TV lechnician for help.

The user may find lhe bochklet “Something About Interference” available
(available from FCC local regional offices) helpful.

FCC Warning: To assure continued FCC compliance, the user must
use only shielded interfacing cables when connecting to a computer
or peripheral. Alsa, any unautharized changes or modifications to the

equipment would vaoid the users authorily to operate.
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Installation Procedure

For inslallation on hard disk;

1. Lochk disk to protecl it Irom changes or erasure.
2. Insert disk.
3. Dragthe CPA Linkicon lo the hard dish.

- _/

/

The serial number of the unit may be found on the upper label localed on
lhe back side.
Write the number below and keep this book, along wilh the proof of

purchase, lo serve as a permanent record of the purchase or lor future
reference.

MODEL NO. KX-RC22
SERIAL NO.

NAME OF DEALER
ADDRESS OF DEALER
DATE OF PURCHASE

wQuicken is a registered trademarh of Intuil.
= Macintosh is a registered trademark of Apple Computer, Inc.



Enjoy the Convenient Functions

The KX-RC22 will allow the user to transmit check transactions from a CPA to
a Macintosh in a QIF file.

Receive/Send ...................... p.18/21 N

Will allow the user to make a back-up copy of the CPA data on

N a disk. Will allow the user to transfer the data from the CPAto a
- Macintosh, then store them onto a disk. -

-

\_‘

Viewonscreen ................c.ca.... p. 24 “\\
' Will allow the user to view CPA CHECK, CARD, CASH, PAYEE
. LIST, CATEGORIE, and TELEPHONE or ADDRESS data on Y
.. the screen. e
Merge ........coiiiiiinnieniinnninnnnnn p.29 T~
" Will allow the user to merge two CPA CHECK data files into one
file. L
.~ CreateQIFFile ........................ p.34 -
' Will altow the user to import CPA CHECK, CARD, and CASH \\..‘
data into Quicken.
Will allow the user to convert the CPA data to Quicken data (QIF .,
. tile), then import the file into Quicken. Where the money trans- //

~. actions can be managed by Quicken. e
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Precautions

Do not place the inlerface adap!or where it is
exposed to direct sunlight or heat.

Do not place the interface adapior on areas with
inlense vibration.

Do not allow any foreign matter to enter the
interior of the interface adaptor.

To prevent electric shock, do not remove any
SCrews,

Use only a soft, dry cloth to clean the interface
adaptor. Water or cleaning fluids may damage
the case or the electronic circuilry.
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Before Using

Page
Unpacking ............ ... .......... 8
PartNames ........................ 9
Installing the Batteries .. ............. 10

Installing Interface Application
SoftwareDisk .. .................. 11

Connecting CPA to Macintosh . . .. ... .. 12
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Unpacking

After unpacking the interface adaptor, make sure that the contents shown
below are not missing or damaged. Report damages or shortages to the store
from which the unit was purchased.

bupyoedun =

Interface adaptor (KX-RC22) .. one  “AA”sizebattery ... ...... four
Interface application Qperating instructions . . . .. one
softwaredisk ... .......... one  Owner information card .. .one

Handling disks
#Never touch the magnetic material inside the cartridge.
- #Never expose the disk to magnetism (found near telephones, loud

speakers, and common magnets).
e Never carry the unit with the disk installed.




Part Names

Overview

interface
cable

Power indicator

Power switch

When the battery power is low, the power indicator will blink

(see page 42).

Rearview

Connector

(2) ((°°°°°°°°°°°°°°°°°°=°°°°°°)J 2
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Installing the Batteries

Turn off the adaptor.

™

HAemove the battery cover by pressing on the cover and sliding it.

sapa)jeg ay) Guielsuy !
~

3. Install the batteries with the battery remaval ribbon underneath them,
using correct polarity (+, —).

Baltery remaval ribbon
(color: orange)

4. Replace the battery cover with the ribbon inside.

10



Installing Interface Application Software Disk

The inlerface applicalion software disk can only be used in Macintosh.
The system requirements are:

® Systemn 6 or later
®1 or more MB RAM

Before using the bundled interface application software disk, il is recom-

mended thal you make a back-up copy and store the original in a safe place.

Turn on the Macintosh.

Loch disk to protect it fram changes or erasure.

Insert dish.

Drag the CPA Link icon to the hard disk.

Remove the interface applicalion software disk and store il in a safe
place.

AW~

11
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Connecting CPA to Macintosh

KX-RC22 is an interface adaptor for data transfer with Macintosh.

A Macintosh to Modem cable {serial cable) must be purchased before
connecting. The following cable is needed:

Macintosh Interface adaptor
8F Mint Din 25P DB-25
(male) (male)

For pin configuration, refer to Modem or Printer port’s specifi-
cation of the Macintosh.

1. Turn off the Macintosh, the interface adaptor, and then the CPA.
Note: When the CPA is connected to the Macintosh, turn off all the

power switches otherwise the electronic circuit may become dam-
aged, and the data or the contents of the memory may change.

2. Open the jack cover of the CPA.

Jack cover

interface connector

When an interface cable is not plugged into the jack, insert the
jack cover. Dust or dirt particles may get into it or static electricity
may occur around it.

12



Connecting CPA to Macintosh

3 « Plug the interface cable of the interface adaptor into the interface
connector of the CPA. Be sure to plug the cable in securely.

4. Connect a Macintosh to Modem cable (serial cable) to the interface
adaptor and to Modem port or Printer port of the Macintosh.
{To set the port, see p. 17.}

Interface connector

Interface adaptor

Interface cable

Back side

R
!

Macintosh

>
F

Modem port

E'm e

Printer port

P

Macintosh to Modem cable
{serial cable)

5. Tumnonthe Macintosh, the interface adaptor, and then the CPA.
When turning it off, follow the above procedure in reverse order.

13
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Operation

Page
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Running the Application Software

After the interface application software-CPA Link disk has been installed cnto the
hard disk according to the instaliation procedure, run the application software by
following the next step.

Operation Display/Description
Double click the == - =
1 CPA Link icon. = KH-RC22 HE
1item 33.3MBindisk 1985 ME
F "
=
@l (o]

16



Setting Communication Parameter

Before starting, confirm that the baud rate is the same in the CPA and Macintosh
{baud rate 9600 is factory set for communication opticns).

Operation

1 Select "Port Settings”
in the Communications
menu.

2 Set the parameters.

Example:
Bzud rate: 9600
Port: Modem

3 Click [OK].

Display/Description

& File Edit ERULTHITELITIIN Windows Cards
T Port settings...

Communication options

Baud Port

Modem
Printer

¢When you connect the Modem cable

with the Printer port, select the
“Printer”.

o|f a serial printer or Appletalk printer is

using the port, the CPA will warn,
“Serial port was in use by another
application”. Select Choaoser in the
Apple menu and turn off Appletalk. If
another application is interfering, the
it must be turned off.

#The other parameters are
automatically set as you see below:
Parity bit: no parity
Stop bit: 1 bit
Data length: 8 bits

o To set the baud rate of the CPA, see the operating instructions for the

CPA unit.

n

17
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Receiving Data from CPA to Macintosh

Example: Below are the procedures for transferring all data from a

KX-RC100 CPA to a Macintosh and storing it in the file

name “ALL”.

18

[ Q0

J

Macintosh
(receiver)

Operation

On CPA:
—

ENTER

To select “ALL"
(if necessary) press
or

On the Macintosh:
Select “Receive from CPA”
in the File menu.

<:|Dalal:][:]D

CPA
(sender)

Display/Description

LINK: [SJEND RECEIVE
PRESS DONE KEY TO EXIT

RILL CHECK
CARD/CASH PHONE
[AlLL CHECK
CARD/CASH PHONE

Receive from CPH...
Send to CPA...
Open...
Sapa...
Merge Checks...
Sape a¢ HiF

Quit eaq




Receiving Data from CPA to Macintosh

Enter the file name
(up to 31 letters/numbers).
Example: ALL

Click [Receive].

On CPA:
To send data press

(ENTER)

On the Macintosh:
When data receiving has
finished, the end of link
display will appear.

CIKH-RC22 =

(PR Link | <=oMAC230
5]
saue file to receive as: [ Receive |
[ | (cencer)
File transfer
Recelving flle: ALL
Bytes: 0 Block: 0 Errors: 0

o The Macintosh is ready to receive

the data.

oPress [ENTER | within 10 error

counts or a fink error will occur.

SENDING . . .

PRESS DONE KEY TO EXIT

End of link

¢ To stop receiving data, click

on the Macintosh.

The receive file wili not be created.
On the CPA the display will show:

LINK ERROR!

19
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Receiving Data from CPA to Macintosh

eWhen an errar occurs, the display
will show:

File transfer error

o |f the same file name already exists,
the display will show:

Replace exristing “ALL” ?

If “Cancel” is selected, the display
will show again:

Y KH-RC22 ¥

Gl 3] —MAC230
0P Link
5]

save file 1o recelve as: [ Receive ]

I_ { cancel

If “Replace” is selected, the file will
be overwritten.

eLink error will also occur in the following cases:
1. Baud rate is different between the Macintosh and the CPA.
2. Incorrect Macintosh to Modem cable (serial cable) or the cable is not
installed correctly.
3. The interface adaptor is not turned on.
4. The incorrect Communication port was selected in the Port Settings.

20



Sending Data from Macintosh to CPA

When sending data, the existing data of the CPA will be deleted.
QIF fite cannot be sent from the Macintosh to the CPA.

Example: Below are the procedures for transferring the file name “ALL"
from a Macintosh to a KX-RC100 CPA.

DO e q;ﬂ:

o000 !
oO00
B [ala]e]s)
0\
Macintosh CPA
(sender) (receiver)
Operation Display/Description

1 On the Macintosh:
Select “Send to CPA" in the

Receive from CPA...
S5end to CPA...
Open...
sapea...
Merge Checks...
Sape as BifF .

File menu.

Quit ®

Q
2 Select the file name.
Exampfe: ALL
O ALL [ — MRAC230
_send ]
=

VdD 0] ysojudey wiodj ejeq Buipuag m

eFile names are sorted in alphabetical
orgder.

21
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Sending Data from Macintosh to CPA

3 Click [Send].

4 Select the type to be
extracted.
Example: ALL Data

On CPA:
—

To select "RECEIVE” press

)

ENTER

To select "Y” press

(»Jor(Y).

0 N O O

22

Options

@ Rl Data

O Checks only

() Card/Cash only

() Checks, Card/Cash, Telephone
(O Checks, Card/Cash, Address

|Cunce|] ﬂ 0K u

#This display will show data type in
the file.

o The KX-RC22 allows the transfer of
telephone and address data. When
sending telephone data to address
data, select “Checks, Card/Cash,
Address”. When sending address
data to telephone data, select
“Checks, Card/Cash, Telephone”.

LINK: [SJEND RECEIVE
PRESS DONE KEY TO EXIT

LINK: SEND [RJECEIVE
PRESS DONE KEY TO EXIT

EXISTING DATA SHOULD BE
DELETED  CONTINUE [N)/ Y ?

EXISTING DATA SHOULD BE
DELETED  CONTINUE N/f¥]?




Sending Data from Macintosh to CPA

9

10

ENTER

On the Macintosh:

Click [OK].

When data sending has
finished this display
appears.

RECEIVING . . .
PRESS DONE TO EXIT

#The CPA will be ready to receive the
data.

o Click within 10 error counts or
a link error will occur.

Flle transier
Tronsmitting file: fiLl
H-Modem Checksum

Done: 256
Tatal: 1920

]

T T T T ] T 1
0 190 20 30 40 S0 o0 70 60 90 100X
d Errors; D

End of link

(o ]

#To stop sending data, click

on the Macintosh.

On the CPA, the display will show:

LINK ERROR!

When an error occurs, the data
stored in the CPA will be deleted.

eWhen an error occurs, the display
will show:

File transfer error

#Link error will also occur in the following cases:
Baud rate is different between the Macintosh and the CPA.
Incorrect Macintosh to Modem cable (serial cable) or the cable is not

1.
2.

3.
4.

installed correctly.

The interface adaptor is not turned on.
The incorrect Communication port was selected in the Port Settings.

23
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Viewing CPA Data on the Screen

This function will allow the confirmation of the data received from the CPA and
CHECK data after merging. If necessary, the CHECK, CARD, and CASH records

can be deleted.

Example: To view the data of the SECOND bank in All file:
#Delete the records CHECK# 3 and 4
eCorrect the balance of SECOND bank from $2419.00

t0 $2238.00
®Save as file name "NEW”

View CPA Data

Operation Display/Description

‘I Select “Open” in the File menu. m

Receive from CPR...
Send to CPA...

Sape... !

Merge Checks...
Sape g9 BiF .

Quit %0

2 Select the file name.

Example: ALL

24



Viewing CPA Data on the Screen

Click

Select an item n the
Windows menu
Example SECOND

& Fflle Edit Communications Windows Cards

RLL Poyee List Categories |
ML Telephone List 111
ALL CASH 1
ALL ABEL CARD |
ALL SECOND
——— ———— 1AL FIRST* ——=
Chech Date Poyes Clais Pmorant
Maber o Category
1000 a7 /94 PANA SHOP P -256 70 10
CD PLAYER UTILITIES ]
OEPOSIT 3 /2 /94  INTEREST e 19
INTEREST nisc
2000 3 /4 /94 BAY AREA UATER o -2 55
HATERE UTL WATER
2001 3 /b /94 PACIFIC 0AS AMD ELECTRIC o -123 44
ELECTRIC/OR UTL GRS/ELEC
1001 3 /9 /64 KEMT TRILOA HOUSE 4 -300 00
SuLts cLOTHIND
1002 3 /10/94  ABC ST P -3 28
BIATHOAY GIFT GIFTS
1063 3 /13/64  TOH S COFFEE SHOP [ -30 65
DINING DI m
Opan balonce 8§87 840 87 Mum racords 14 Rocount balancs  §2 343 87 |Ch)
L = -

| Windows S

FIRST *
Card |I

Cash
Telephone List
Payee List
Categories

oThe "*" character indicates the
primary account

eWhen you view the card data, select
“Card” in the Windows If other card
names are entered, select your
desired card name in the Cards
menu

25
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Viewing CPA Data on the Screen

Delete CPA Data

Operation

1 Select the records to
delete.
Example:
CHECK# 3 and 4

Select “Clear” in
the Edit menu.

N

26

Display/Description

I ALL : SELOND B

Category

TOH'S COFFEE SHOP
DINING

FBC GAS STATIODN
AUTD FLEL

N FUT
TOH'S COFFEE SHOP
QIHING
REC GRS STATION
AUTD

FUEL

3

n balonce  $2,900.00  Hum racords & ARecount balonce  $2,413.00

finn g

f et HH
fopy H#A
Paste S

Number  Mams Cat

INING
3 /31794 ABC GRS STATION
AUTI

GRSOLIH 0 FUEL

Opan boiance  $2,500.00 Hus records 4 Account balance  $2,419.00




Viewing CPA Data on the Screen

Select "Change Acc! Balance”
in the edit menu.

iIntto b 4
[t K
L #l
Pasie )
Clear

Change Acct Balance...

Carrect balance,
Example: $223B8.00

Enler Account Balance
SECOND

s [Ezsmod_]

Click [OK].

Select "Save” in the
File menu.

Send to CPH...
Open...

Save as QIF...

Receive from CPA...

Merge Checks... l

27
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Viewing CPA Data on the Screen

Enter the lile name
7 {up to 31 letters/numbers). _
) oL & = MACzI0
Example: NEW @ [P0 Link
[
Save wilh changes as: lﬂ Save As I
LNHq 7 Cancel

8 Click :

28



Merging CPA Data Files

The merge function combines the check data from two files by merging the
transaction data from the “Merge from” file into the “Merge into” file. An output
file will be created which includes all transactions and whose balance is calcu-
lated by adjusting the balance from the "Merge into” file for the transactions from
the “Merge from” file. The criginal contents of the “Merge into” file and the
“Merge from” file will remain unchanged.

lNote:I The account names in both files must be the same.

Example: Below is the procedure for merging the transaction data from
“CHECK2” into "CHECK1” and creating the outpuli file
“MERGE". “CHECK1" contains data for check date 03/01/94
through 03/31/94 and “CHECK2” contains the data for check
date 04/01/94 through 04/30/94.

Operation Display/Description
TR - |
Receive from CPA...
Send to CPA...
Open...
sapa...

Merge Checks...
Sape as BiF ..

2 Select "Merge into” file.
Example: CHECK1

C ALL O SOMAC230
C CARD

0 CHECK2

[Ferge into)

3 ik [Mergeio).

4

9
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Merging CPA Data Files

30

4

o O

Select the account
Example FIRST

Click

Select range
Example By Date

Enter start and end date

of "Merge into” file

Example Start 03/01/94
End 03/20/94

Ciick

Select the account

SFIHST
SECOND

(C Both Accounts

Select range from account
FIRST

O All Data
gﬂg Date

By Check Number
start  |[E/01/94
End 03/31/94

{tencel ]  [_ox_)

Select range from account
FIRST

O All Data

@ By Date

QO By Check Number
Start 03/01/94
End 03/20/94

(cancer] [ ox ]




Merging CPA Data Files

10
11

12

13

Select "Merge fram” file.
Example: CHECK2

Gick [Herge from].

Select range.
Example: By Date

Enter start and end date

of “Merge from” file.

Example: Start 04/01/94
End 04/20/94

Click [OK].

$IKH-RC22

O ALL T S MAC230

D CRRD _

D chEcks
[T]

Select range from account
FIRST

(O Al Data
Qﬂy Date

start  |[(E/01/94

End 04/30/94
Cancel I 0K I

Select range from account
FIRST

O Rl Data
@ By Date

Start 04/01/94

End 04/20/94
|Cancel ﬂ 0K I

31
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Merging CPA Data Files

14

15

32

Enter an output file name
{up to 31 letters/numbers).
Example: MERGE

Giick [Save As).

When merging has
finished this display
appears.

Y KH-RC22 =

0 RLL 0] —MnAcz3o0
D CARD _

D LHECKE
3 LHECK?2

b Deskto

& PO Link

O

Save with changes as: | Save As I
[meReH | (cencer )

Merge file created

eWhen the accounts are not the
same, the display will show:

Both check accounts
must have the same

name

eWhen there is no data to be
extracted, the display will show:

No records in account

oWhen the number of merged records
exceeds 2,000, the display will show:

Too many check
records to merge




Merging CPA Data Files

®When there is the same check
number >0, the same record with
check number 0, or the same deposit
record both in the "Merge into” file
and “Merge from’ file, the disptay will
show:

Duplicate Check Records
Merge One | (Merge Both
Copy Copies

Merge One Copy: Makes only one
copy of each
duplicate record.

Merge Both Copies: Makes two

copies.

s The records will be stored in the
order of date.

* If a data range of the “Merge into”
file is specified, the balance will not
be caiculated.

® All other data from the “Merge into”
file (paylist, card, cash, telephone

or address) will be copied 1o the
new file,

sajl4 Bleq vdo bubiay m
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Creating QIF File

CPA CHECK, CARD and CASH data can be imported into Quicken.

CPA data can be converted to Quicken data (Q!F File}, then imported into
Quicken.

The money transactions can be managed by Quicken.

Example: To convert the ALL to Quicken data as file name “QKN. QIF":
The bank account is “FIRST”,
ALL includes "FIRST" and "SECOND" accounts,
and the data ranges from 03/01/94 to 03/31/94.

Operation Display/Description

Select “Open” in the

File menu. m "
Receive from CPH...
Send to CPA...

e

Sapa...
Merge Checks...
Save as i

Quit 0

2 Select the file name
Example: ALL
—MAC230

Desktop

®File names are sorted in alphabeti-
cal order.

34




Creating QIF File

: 7 & Flle Edit Communications Windows Cards
3 Cth ) ALL : Payee List

| Cotegories

|
1

0InING DINING

ALL : Telephone List
ALL : CASH |
RALL : ABL CARD 1
ALL : SECOND
ALL:-FIRST *
Chach  Date Payen Closs Amount
Husber  Hamo Cotegary
1000 3 .'| /94 PANA SHOP P -258. 70 |
PLAYER UTILITIES
DEPRSIT 3 ,'7 ,uu IMTEREST L 19,79
2000 3 .'4 .194 UAY RAER »mzn cwnw [] -20.83
TERE UTL WATER
2001 > /6 /94 PACIFIC OAS AMD ELECTRIC o -123,44 |
ELECTRIC/0AS UTL GRS /ELEC
D01 3 /9 /G4 KENT TAILGA HOUSE P 300,00
SUITS CLOTHING
1002 3 /10/54  RBC STORE (] -25.28
BIRTHOAY BIFTS
1003 3 /12/8%4  TOM'S COFFEE smP [ -30.03

4 Select windows for data to be
converted {account 1, account
2, card, cash). -T
Example: “FIRST" FiR ST

SECOND
Card
Cash

Windows

Payee List
Categories

Opan balonts 87,040 87 Mum records 14 Account bakenca  §2,343.47

Telephone List

2K

5 Select "Save as QIF” in e#When the window of Telephone List,
the File menu. Address List, Payee List and Catego-
ries is selected, “Save as QIF” will

not be displayed.

Send to CPA...
Open...

Save...

Merge Checks...
Save as OQIF...

Receive from CPA...

on4 410 buneasd n
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Creating QIF File

6 Enter the converting file
name
Example: QKN. QIF

Click [Convert ].

\I

Select range from
account
Example: By Date

oo

9 Enter start and end date
of “Convert” file.
Example:
Start  03/05/94
End 03/15/94

36

Y KH-RC22 *
0 ALY {f oOMRAC230
INRNLE: —
NN
Q ::ms(:rgz
QPR ik
I3 MERSE
Load CPA and convert to: [ convert |
[axn.0F | (cancel )

Select range from account
FIRST

O All Data
gﬂg Date

By Check Number
start  |[[H/01/94
End 03/31/94

Select range from account

FIRST
ORI Data
@ By Date
O By Check Number
Start 03/05/94
End 03/15/94




‘I 0 Click [OK]. QIF file created

When creating QIF file
has finished this display
will appear.

¢lf the input file is an invalid data file
or has no data to be extracted, the
display will show “Cannot create
file".

Creating QIF File

eCLASS “B”, “P”, and “O” will be converted to “Business”, “Personal”,
and “Others”, respectively.
#CPA assumes that the version of Quicken is 3.0.

aj4 41 buneasd n
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Quit

This function will terminate the CPA interface application.

Operation Display/Description

1 ﬁjﬁsf Quit” from the File
Receive from CPAH...
Send to CPA...
Open...

Save...

Merge Checks...

Save as QIF...

Quit #0

eif changes have not been saved
when "“Receive from CPA”, “Open”,
“Merge Checks”, or “Quit” is se-
lected in the File menu, the display
will show “Save file with changes?”.
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RS-232C Serial Interface

Caution
[ Cable: Use a shielded cable 1.8 meters (6 ft} or less in length.

RS-232C connector pin assignment

s
- \ e T o o o o e e \ / ™
'\. \&@@@@@@@@@©@©®©©®©@%@ ©©@ '\"
-

Pin configuration

Pin No. Signal Direction
1 SG
2 TXD QUTPUT
3 RXD INPUT
7 SG
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RS-232C Serial Interface

Signal descriptions

SG...Signal Ground

Connected te the signal ground of the adaptor’s circuit board.

RXD...Receive Data

Inputs serial data form the computer. SPACE (+ side) indicates “0" data;
MARK (- side) indicates “'1” data.

TXD...Transmit Data

Cutputs serial data to the computer. SPACE indicates “0" data; MARK
indicates “1” data.

Data Input: Parity bit: no parity
Stop bit: 1 bit
Data length: 8 bits

Data Input Codes: Character: ASCII
Graphics: 8 bit

Transmission Speed (Baud Rate): 2400, 4800, or 9600

41
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Replacing the Batteries

Weak battery: If the battery power is low, the “Power indicator” light will
flash. Replace with new batteries.

(Battery Precautions: )

If improperly used, the batteries may leak and cause corrosion. Therefore,
observe the following:

#Do not install the batteries using incorrect polarities.

e Do not mix bateries (old and new).

Do not mix battery types (carbon and alkaline).

®Remove all the batteries when not using the unit.

Do not charge, short-circuit, disassemble, heat, or dispose of in fire.

/

1. Turnoffthe adaptor.

2. Remove the battery cover by pressing on the cover and sliding it.

« Replace the hatteries with new ones using the correct polarity (+, —).
Removing batteries Installing batteries

souoneg oyl budeiday E
W

Battery removal ribbon
(color: crange)

4. Replace the battery cover with the ribben inside.
42



Troubleshooting Guide

If trouble occurs, check the following points before returning the interface

adaptor for service.

Trouble

Cause

Procedure

The power switch is
on, but the power
indicator is not lit.

The batteries are not
installed or they are
installed incorrectly.

Install the batteries
correctly.

The batteries are dead.

Replace the batteries
with new ones.

CPA does not transfer
with the Macintosh.

The interface adaptor,
the CPA, or the
Macintosh is not
turned on.

Turn ¢on the interface
adaptor, the CPA, and
the Macintosh.

The cable of the
interface adaptor or
the Macintosh to
Modem cable is not
connected properly.

Properly connect the
cable of the interface
adaptor and Macintosh
to the Modem cable.

Specifications

Power Source
Interface

Operating Temperature
Operating Humidity
Storage Temperature
Dimensions

Mass {Weight}
Battery Life

. 4 “AA” size batteries DC 6V

: RS-232C

- 5°C (41°F)—35°C (95°F)

: 20—80% RH

: —20°C (—4°F)—60°C (140°F)
: 115 (W)x173 (D)x35 (H) mm
{41742" (W)x61348" (D)x 138" (H}}

© 0.225 kg (0.5 Ib)

: About one hundred days
When sending data 4 times a day

at 20°C (68°F)
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List of Display Messages

Message

A file system error has occurred . . . .

Both check accounts must have

thesamename . ..............

Cannot createfile ...............

Cannot save file

Duplicate check records . ... ......

End check # is less than

statcheck# .. ...............

End date is before start date

Endoflink ....................

File transfer error

Merge filecreated .. ........... ..

No records in account

Not enough memory to run

CPALINK ....................
QlIF flecreated .. ...............

Replace existing “file name™?

Save file with changes? ..........

Serial port is in use by
ancther application.

Thediskislocked ...............
Too many check records to merge . .

Unable to view file

44

Description

A file system error has occurred.

The check accounts do not have the
same name.

Creating file was unsuccessful or the
disk fs full.

Saving file was unsuccessful.
Duplicate check records exist.

End check # is less than start check #.
End date is before start date.
Transmission or reception is done.

An error has occurred while sending or
receiving data. Please refer to page 20.

File merging was successful.

Check record does not exist in
account.

Not encugh memory to run CPA Link.
Creating QIF file was successful.
The same file name already exists.

The file with changes have not been
saved.

A serial printer or Appletalk printer is
using the port.

Write protect tab is up.

The number of merged records
exceeds 2,000.

File is corrupt or wrong format.
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Servicenter Directory

PRODUCT INFORMATION - OPERATION ASSISTANCE - LITERATURE
REQUESTS - DEALER LOCATIONS

DIAL TOLL FREE: 1-B0D-CPA-7033 (1-BD0-272-7D33)
Cuslomer Service Cenler 2F-3, One Panasonic Way, Secaucus, NJ 07094 (Headquarters)
201-348-3090 (3;00arm-B:00pm Monday—Friday, EST)

SERVICE INQUIRIES Regional Cusiomer Care Department

NORTHEAST MIDWEST WESTERN SOUTHERN

2221 Cabal Boulevard Wesl 1703 Nerlh Randall Road ESS0 Matella Avenue 1854 Shachlelord Ceurt
Sulls A Elgin, IL 80123 Cypress, Ca B0OG20 Suile 4106

Langhorna, PA 15047 70B-468-5530 714-373-7440 Norcross, GA 30053
215-741-0678 Cavara: Cavera: 4p4-717-6628

Covera: IL, IN, 1A, K5, HY, MI, AM, AZ CA, CO, ID, Covera;:

CT, DE, ME, MD, MA, MN, MO, NE, ND, 5D, MT, NV, NM, OR, UT, AL, AR, FL, GA, LA,

NH, NJ, NY, FA, RI, VT, WI, Weslem OH Wa, WY_HI MS, NE, DH, 5C, TN, TA
VA, DE, WV, Easlarn OH

PRODUCT SERVICE . Faclory Servicenters

TENNESSEE

313-Blh Avenue Soulh
Nashville, TN 37203
F15-244-4434

AUTHORIZED SERVICENTERS : PARTS DISTRIBUTOR LOCATIONS

To locale an independeni aulhorized servicenler of parls distribulor in your area, within the USA
dial toll free 1-80D-545-2672, 24 hours a day, 7 days a weeh.

ACCESSORY PURCHASES

1-800-332-5368 (Consumer Orders Only)

Malsushila Services Company Box 01, 545 Tollgals Road Suite G, Elgin, IL 60123
(d8:00am-7:30pm Monday-Thursday; 8:00am-5:00pm Friday, 5:00am—12:30pm Salurday; CST)
(Visa, Maslercard, Discover card, Check or Money Order)

To ship the product:

Carelully pack and send il prepaid, adequately insured and preferably in the
original carton. Attach a postage-paid |etter, deiailing the complaint, to the
oulside af the carton. DO NOT send the product to the Executive or Regional
Sales offices. They are NOT equipped to make repairs.



PANASONIC COMPANY, DIVISION OF
MATSUSHITA ELECTRIC CORPORATION
OF AMERICA

One Panasaonic Way, Secaucus, New Jersey
07094

PANASONIC COMPANY (WEST) OF
AMERICA, DIVISION OF MATSUSHITA
ELECTRIC CORPORATION OF AMERICA

G550 Kalella Avenue, Cypress, CA 90630

PANASONIC CHECK PRINTING ACCOUNTANT
INTERFACE ADAPTOR
LIMITED WARRANTY

Panasonic Company or Panasonic Company (Wasl)
ol America (collactively referred 1o as “Panasonic')
will repair this producl wilh new or rebuill parts, Iree
of charge, in the U.S.A. from the dals of Ihe original
purchase in the evenl ol a defecl in malerials or work-
manship as lollows:

Inlerdace Adaplor—Ior One (1) Year.

Balleries (When applicable)—Naw rachargeable bal-
leries in emchange lor delective rechargeable balter-
ies—Far Llen (10) days.

Non-rechargeahle bateries are nol warranied.

Disketles—This limiled warranty applies only o |he
medium on which lhs software program is recorded,
nol lhe softwars program ilself. Excepl for lhis limilad
warranly on lhe medium, Panasonic makes no war-
ranlies wilh respecl lo the softwars program, ils
medium, lhe user manual or the resulls, use or per-
lormance theraaol.

It, as a resul ol a defacl in materials or workmanshig,
a lailyre occurs in lhe medium on which tha soAware
program is recorded, and lhe User returns il poslage
prapaid, ad=qualely insured, within Len (10) days from
lhe dale ol purchasa by |he User, accompanied by
prool of purchase and an esplanalion of the suspecled
delect, Panasonic will replace tha medium Ires of
chargs.

Carry-in or Mail-in service in the conlinenlal U.5.A.
can be oblained during lhe warranly pericd by con-
lacling a Malsushila Services Company (MSC) Fac-
lory Servicentler lisled in lhe Servicenler Direclory or
call loll free 1-BO0-545-2672 Ipcale an aulhorized
MSC Servicenler,

This Warranty is exlanded only lo the ariginal pur-
chaser. A purchase receipl or olher proal ol dale ol
original purchase will be required befara warranty per-
lormance is renderad.

This warranty only covers lailures due lo defecls in
Malerials or warkmanship which occur during normal
use and does 1ol eover lhs prinl ribban or damags
which oceurs in shipmenl or failures which ara caused
by producls nol supplied by Panasonic or lailures
which resull from accidenl, misuse, abuse, naglecl,
mishandling, misapplicalion, inlerfacing, sel-up, ad-
justmenis, improper mainlanance, line pawer surge,
miroduction of sand, dusl, humidity and liguids, mod-
itication, or commercial use of lhe producl, such as
hatsl, alfice or renlal use of Ihs producl, or service by
anyone olher lhan an MSC Faclory Servicentar or
damage lhal is alribulable o acls of Ged.

LIMITS AND ENCLUSIONS

Therz are no sNpress warranlies emcepl as lislad
above, PANASONIC SHALL NOT BE LIABLE FOR
INCIDENTAL, CONSEQUENTIAL, OR PUNITIVE
DAMAGES, INCLUDING, WITHOUT LIMITATION,
LOSS OF GOODWILL, PROFITS DR REVENUE,
LOSS OF USE OF THIS PRODUCT OR ANY ASSD-
CIATED EQUIPMENT, COST OF SUBSTITUTE
EQUIFMENT, DOWNTIME COSTS, DR CLAIMS OF
ANY FARTY DEALING WITH BUYER FOR SUCH
DAMAGES, RESULTING FROM THE USE OF THIS
PRODUCT, OR ARISING DUT OF ANY BREACH OF
THIS WARRANTY DR CONTRACT, NEGLIGENCE,
OR ANY OTHER LEGAL THEORY. ALL EXPRESS
AND IMPLIED WARRANTIES, INCLUDING THE
WARRANTIES OF MERCHANTABILITY, ARE LIM-
ITED TO THE AFPLICABLE PERIOD SET FORTH
ABOVE. Some slales do nol allow lhe exclusion or
limilation of incidenlal or consequenlial damage, or
limilalions on how long an implied warranly lasls, so
lhe above exclusions or limilalions may nol apply lo
you.

This warranly gives you specilic legal righls and you
may also have olher righls which vary from slale lo
slale.

Il a problem wilh |his product develaps during or afler
lhe warranly period, you may conlacl your dealer or
Servicenler, If lhe praoblem is nol handled lo your
salisfaclian, lhen wrile Io Ihe Cuslomer Service Can-
ler al the company addrass indicaled abave.
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Panasonic Company
Division of Matsushita Electric Carporation of America
One Panasonic Way, Secaucus, New Jersey 07094

Panasonic Company {(West) of America

Division of Matsushila Electric Corparalion of America
6550 Katella Avenue, Cypress, California 90630
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